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Learning Objectives
After completing this course, you will be able to:
●

Understand the 3D Modeling workspace and using the Dashboard.

●

Display 3D objects from preset isometric viewpoints.

●

Display 3D objects from any desired viewpoint.

●

Use the 3DORBIT command to dynamically rotate the display of a 3D model.

●

Set a visual style current.

●

Construct 3D solid primitives.

●

Modify solids using Grip-editing.

●

Extrude the surface of a solid using the PRESSPULL command.

●

“Hollow out” a solid using the SHELL command.

●

Create complex solids using the UNION, SUBRACT, and INTERSECT command.

●

Describe the function of the world and user coordinate systems.

●

Move the user coordinate system to any surface.

●

Save and manage user coordinate systems.
The use of three-dimensional (3D) drawing and design as a tool is becoming more

prevalent throughout industry. Companies are discovering the benefits of 3D modeling in
design, visualization, testing, analysis, manufacturing, assembly, and marketing. Threedimensional models also form the basis of computer animations, architectural walkthroughs,
and virtual worlds used with virtual reality systems. Drafters who can design objects, buildings,
and “worlds” in 3D are in demand for a wide variety of positions, both inside and outside of the
traditional drafting and design disciplines.
This course provides an introduction to several aspects of 3D drawing and visualization. To
be effective in creating and using 3D objects, you must first have good 3D visualization skills,
including the ability to see an object in three dimensions and to visualize it rotating in space.
Once these concepts are understood you can begin mastering the basic tools of solid modeling:
AutoCAD’s solid primitive commands. These tools are truly the “building blocks” to being able
to construct any object in 3D and prepare you for entry into an exciting aspect of graphic
communication.
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Basic Overview of the Interface
Workspaces
A workspace is a drawing environment in which dockable windows, toolbars, menus, and
Dashboard control panels are displayed for a specific task. A workspace stores not only which
of these tools are visible, but also their on-screen locations. You can quickly change
workspaces using the Workspaces toolbar. By default, the Workspaces toolbar is docked to the
left of the Layers toolbar in the AutoCAD Classic workspace and to the left of the Standard
toolbar in the 3D Modeling workspace. In the 2D Drafting & Annotation workspace, it is
displayed to the left of the Standard Annotation toolbar.
In order to use the default 3D “environment”, you must start a new drawing file based on the
acad3D.dwt template and set the 3D Modeling workspace current. All discussions in the
remainder of the course assume that AutoCAD is in the default 3D environment.

EXERCISE #1
1. Select the File pulldown menu, and pick New…
2. Select acad3D.dwt from the list of template files
3. Pick the Open button, or double-click on the template file name
4. Select the dropdown arrow on the Workspaces toolbar
5. Select 3D Modeling from the list of workspaces
6. The rest of the course/handout assumes you will always have the 3D Modeling
workspace active.
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Dashboard
Workking in the 3D
3 modeling environmen
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1 Each control panel co
for working in 3D.
The Dashboard is a dockablle window, or
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e right side of
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screen. However,
H
to increase the
e size of the drawing
area, you
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t float the Dashboard by
b dragging
it into the
e drawing are
ea. Like all other
o
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windows) and toolba
ars, the Dash
hboard can be
b docked
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e on the screen using th
he grab bar or
o title bar.
anywhere
If you prefer to have
h
the Dasshboard floa
ating, you
nt to enable the
t auto-hid
W
this
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feature iss enabled, th
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d to just the
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e of the draw
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y the full Dasshboard, sim
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displayed

Figure 1. The Dashboard from the 3D
D
Modeling workspace.

the curso
or over the title bar. Then
n, select the
e tool you
want to use
u and whe
en the cursorr is moved back
b
into the drawing are
ea, the Dash
hboard is again
reduced to the title bar. To enablle the auto-h
hide feature,, pick the Au
uto-hide butto
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ashboard title
e bar.
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A
Docking
mustt also be che
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oard. To display the full Dashboard,,
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simply move the cursor over the anchored title bar. Then, select the tool you want to use and
when the cursor is moved back into the drawing area, the Dashboard is again reduced to the
anchored title bar.
You can close the Dashboard by picking the close control button (X) at the top of the title
bar, or the right of the grab bar if docked. The DASHBOARD command can be used to display
the Dashboard. The display of the Dashboard can also be toggled on and off using the Tools
pull-down menu.

Control Panels
The seven default control panels that are displayed in the Dashboard in the 3D environment
provide all of the functions you need to design, view, and render your 3D model. Each panel is
identified by an icon in the upper-left corner of the panel. If you pause the cursor over the icon,
the name of the panel is displayed. The panel can be expanded or condensed by picking this
icon or by picking the maximize/minimize arrow in the lower-left corner of the panel. The
maximize/minimize arrow is displayed when the cursor is over the vertical stripe on the left side
of the panel. This stripe is dark gray when the panel can be expanded and orange when the
panel is expanded.

EXERCISE #2
1. Experiment with the Dashboard and its possible locations: floating, docked or anchored.
2. Remember that in order to be able to anchor the Dashboard, Allow Docking must be
checked.
3. Leave the Dashboard in the mode that is most comfortable.

Displaying 3D Views
It does not do much good to understand how to draw in 3D space if you cannot see what
you draw in three dimensions. The default view in the 2D environment based on the acad.dwt
template is a plan, or top, view of the XY plane. The default view in the 3D environment based
on the acad3D.dwt template is a pictorial, or 3D, view. AutoCAD provides several methods of
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g your viewp
point to produ
uce differentt pictorial vie
ews. The vie
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m
for changing yo
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d
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F
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w pull-down menu or select
the appro
opriate butto
on on the Vie
T
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3 view is
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options in
i the cascading menu. The PLAN command is discussed in more deta
ail
U
Named UCS
later in th
he course.

EXERC
CISE #3
1. Open
O
the DIC
CE.dwg file
2. Experiment
E
with
w isometricc and orthog
graphic preset views fou
und in the 3D
D Navigate
co
ontrol panel of the Dash
hboard.
3. To
T make the dots on the dice white, go
g to the Op
g box, selectt the Display
ptions dialog
butto
ta
ab, pick the Colors
on, highlightt “3D paralle
C
el projection
n” in the Con
ntext: pane,,
highlight “Uniiform backg
p
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ground” in the Interface
e element: pane,
th
he Color: drropdown list. Pick the Apply & Clos
se button to dismiss the Drawing
b
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ox.
W
Window
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ors dialog box,
ons dialog bo

Dynam
mically Ch
hanging a 3D View
w
The 3DORBIT command
c
is a powerful and
a easy-to--use command for creatiing pictorial
views of a 3D object.. It allows yo
ou to dynamically rotate the view of a 3D object in real time.
There are
e two basic modes for th
he 3DORBIT
—constraine
ed and free. These are
T command—
discusse
ed in the nex
xt sections.

Constra
ained Orbitt
This command is
s accessed via the third button from
m the left in th
he top row of
o buttons in the
3D Navig
gate control panel of the
e Dashboard. See Figure
e 3.
A co
y press an
nd
meanss that when you
onstrained orbit
o
hold the pointer butto
on, the view can be rotated up 90°,
ontally 360°.. You cannott display an
down 90°°, and horizo

Figure 3. The Constra
ained Orbit Button

upside-down view off the opposite side of the
e model.
d. This is the
e default mode when the
e
Within these constraints, the model can be freely rotated
W
the command is in
nitiated, the constrained
c
d at
orbit cursor is displayed
command is typed. When
the pointer position.
en in constra
ained orbit mode,
m
a varie
ety of optionss are availab
ble from the shortcut me
enu.
Whe
In additio
on, you can select
s
manyy of these op
ptions using the
t 3D Navigate toolbarr. These opttions
are discu
ussed in the following se
ections.
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Professiional Tip
The consstrained mod
de of the 3DORBIT com
mmand can be
b transparently accesse
ed from within
another command
c
orr with no com
mmand activve. Press an
nd hold the [S
Shift] key an
nd
simultane
eously press
s and hold th
he mouse wheel. Then, move the po
ointer to ach
hieve a new
viewpoint. If you undo the comm
mand within which
w
RBIT was acccessed, the view is returrned
3DOR
to the pre
evious displa
ay.

Free Orrbit
This command is also accesssed via the third button from the lefft in the top row
r
of button
ns in
N
control panel off the Dashbo
oard. This button
b
is a flyyout – you must
m
hold the
e pick
the 3D Navigate
button do
own to allow
w other button
ns to fly out.. The secon
nd button is Free
F
Orbit. See Figure 4.
W
Without
lettin
ng go of the pick button,, move the cursor
c
over the
t
F
Free
Orbit button, the le
et go of the pick
p
button. This
T
will activvate
t comman
the
nd. (Free Orrbit then beccomes the de
efault comm
mand
b
button
for the third butto
on in the top row.)
me movemen
nt as in
Free orrbit mode allows the sam
c
constrained
y can also
o vertically ro
otate the view
w
mode, but you
Figure 4.. The Free Orbit Button

3
360°.
When the
t comman
nd is initiated
d, a green circle is displa
ayed

in the mid
ddle of the current
c
viewp
port. This is called the trrackball, or arcball.
a
By dragging insid
de or
outside of
o the trackball, the view of the objecct is dynamiccally change
ed. The cursor shape
indicatess which actio
on can be pe
erformed. Ea
ach shape iss a visual cue
e to indicate
e which type of
action will be perform
med if you pick, hold, and
d drag (movve the pointin
ng device). As
A in the
ned orbit mode, the shorrtcut menu shown
s
of opttions is available.
constrain

Basic 3D Orbit Dis
splay Conttrols
Within the 3DOR
RBIT comma
and, you havve the abilityy to toggle be
etween consstrained orbiit,
an, and realttime zoom by
b using the shortcut me
enu. Display the shortcutt
free orbitt, realtime pa
menu by right-clickin
ng and then pick
p
Other Navigation
N
M
Modes.
Notice
e that a check mark app
pears
next to th
he current mode.
m
Also no
otice the num
mbers next to
t each item
m. The mode can be swittched
without displaying
d
the
e shortcut menu
m
by typin
ng the numb
ber. See Fig
gure 5.
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Additionally, when in orbit mode and Enable Orbit Auto Target is on (checked) in the
shortcut menu, as shown in Figure 5, the viewpoint is rotated about the center of the object
display. When off (unchecked), the viewpoint is rotated about the center of the viewport. In this
case, the objects may be rotated out of the viewport display.

Figure 5. The 3DOrbit Shortcut Menu

Projection and Visual Aids
Using the 3DORBIT command, a 3D model can be displayed using a wide variety of
options. These include projection methods, such as parallel and perspective; access to visual
styles; and visual aids, such as a spherical compass, grid, and shaded UCS icon. These options
are selected in the shortcut menu available after the 3DORBIT command has been entered,
and are described in the following sections.

Projection
The projection of a pictorial view refers to how lines that recede into the background are
treated. Projection of a 3D model can be either parallel or perspective.
In parallel projection, the sides of objects project parallel to each other. Axonometric views
(isometric, dimetric, and trimetric) are all parallel projections.
In perspective projection, the sides of objects project toward one or more vanishing
points. In 2D drafting, it is common to represent an object in pictorial as a one- or two-point
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perspective, especially in architectural drafting.
Once the 3DORBIT command is exited, the selected projection remains current. You can
pan and zoom in both parallel and perspective projections. Additionally, objects can be edited in
either type of projection once the 3DORBIT command is exited.
Professional Tip
You can quickly change between projections at any time by picking the appropriate button in the
3D Navigate control panel in the Dashboard. If the 3DORBIT command is active, you may
need to orbit the display slightly before the projection is changed.

Visual Aids
Visual aids help relate the view to the UCS. There are three visual aid options in the
3DORBIT command.
•

Compass

•

Grid

•

3D UCS icon

When the compass is on, a spherical 3D compass with the same diameter as the trackball
appears. The compass has tick marks and labels indicating the X, Y, and Z axes. The compass
can provide a reference for the current UCS. The COMPASS system variable controls this
display, and is set to 0 if this item is not checked. If the compass is turned on, it remains on after
the 3DORBIT command is exited, except when the 2D Wireframe visual style is current.
The grid is displayed within the drawing limits when Grid is checked in the shortcut menu. If
the current visual style is 2D Wireframe, the pictorial grid is displayed. The grid setting
corresponds to the setting in the Drafting Settings dialog box. It is on by default. The setting is
retained after the 3DORBIT command is exited.
The shaded 3D UCS icon shows the orientation of the UCS. The X axis is red, Y axis is
green, and Z axis is blue. When UCS icon is checked in the shortcut menu, the UCS icon is
displayed. This is the default setting. When off (unchecked), the UCS icon is not displayed. This
setting is not retained when the 3DORBIT command is exited. The UCSICON command
controls the visibility of this icon outside of the 3DORBIT command. The 3D UCS icon is very
useful and should be displayed at all times.
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3D Orbit View Options
The 3DORBIT command is extremely versatile because you can use a variety of
established views to create a display. In addition, you can use the 3DORBIT command to rotate
the viewpoint and then reset the viewpoint to the view that was displayed prior to using the
command. Three items in the 3D orbit view shortcut menu allow you to set views.
•

Reset View. Resets the view that was displayed before 3DORBIT was invoked. The

command remains active.
•

Preset Views. Displays a list of the orthographic and isometric presets. Note: Selecting

a preset orthographic view here does not change the UCS.
•

Named Views. The named views in the drawing are displayed in this cascading menu.

The drop-down list in the 3D Navigation toolbar also displays all preset and named views.
When the 3DORBIT command is active, simply select a view from this list to display it. If you select
one of the orthographic presets while the 3DORBIT command is active, the UCS is not
changed. However, if you select one of the orthographic presets from the drop-down list on the
3D Navigation toolbar when the 3DORBIT command is not active, the UCS is changed. Saved
views can also be selected from the drop-down list in the toolbar when the 3DORBIT command
is not active.

3D Orbit Camera Settings
Two 3DORBIT command options enable you to change the 3D display based on functions
of a camera. The distance between camera and object can be adjusted, as well as the amount
the camera is swiveled on a tripod. These options can be selected from the 3DORBIT shortcut
menu, the 3D Navigation toolbar, or typed at the keyboard.
The distance between the viewer and the object can be set by adjusting the camera
distance using the 3DDISTANCE command. To access this command, type the command or
use the 3D Navigation toolbar, View pull-down menu, or 3D Navigate control panel in the
Dashboard. You can also select Adjust Distance from the Other Navigation Modes
cascading menu in the 3DORBIT shortcut menu. The cursor changes to arrows pointing up and
down. Hold the pick button and move the cursor up to get closer to the object, or move it down
to increase the camera distance from the object. Be warned, however, that this can distort the
objects in the display.
In addition to adjusting the camera distance, you can also change the view by swiveling the
camera. The 3DSWIVEL command is similar to the PAN command except that the location from
12
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which you are viewing the objects does not change, just the direction in which you are looking.
To swivel the camera, use the 3DSWIVEL command. To access this command, type the
command or use the 3D Navigation toolbar, View pull-down menu, or 3D Navigate control
panel in the Dashboard. You can also select Swivel from the Other Navigation Modes
cascading menu in the 3DORBIT shortcut menu. The cursor changes to a camera icon. Hold
the pick button and move the cursor to swivel the camera in any direction.

EXERCISE #4
1. If it is not already so, open the DICE.dwg file
2. Experiment with the constrained and free orbit options of 3DORBIT. Be sure to try the
visual aids such as, compass and grid. Also try the preset views, similar to the isometric
and orthographic preset views found in the 3D Navigate control panel of the
Dashboard.
3. Try to closely match some of the views presented below in Figure 6. As you are doing
so, be sure to pay attention to the UCS icon “tripod”. It can be a very handy tool,
providing hints as to which way you might need to drag the cursor to obtain the desired
view.

Figure 6. Try to Create the Views Above
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Creating a Continuous 3D Orbit
The most dynamic aspect of the 3DORBIT command is the ability to create a continuous
orbit of a model. By moving your pointing device, you can set the model in motion in any
direction and at any speed, depending on the power of your computer. An impressive display
can be achieved using this command. To access continuous orbit mode, type the command or
use the 3D Navigation toolbar, View pull-down menu, or 3D Navigate control panel in the
Dashboard. You can also select Continuous Orbit from the Other Navigation Modes
cascading menu in the 3DORBIT shortcut menu. The continuous orbit cursor is displayed. This
appears slightly different than the orbit cursor.
Press and hold the pick button and move the pointer in the direction that you want the
model to rotate and at the desired speed of rotation. Release the button when the pointer is
moving at the appropriate speed. The model will continue to rotate until you pick the left mouse
button, press [Enter] or [Esc], or right-click and pick Exit or another option. At any time while the
model is orbiting, you can left-click and adjust the rotation angle and speed by repeating the
process for starting a continuous orbit.

EXERCISE #5
1. If not already the case, open the DICE.dwg file
2. Go ahead! You know you want to! Experiment with the continuous orbit capability. See
how fast you can get it spinning. See how slow you can spin it. Make it spin vertically
as well as horizontally. See if you can get it spinning “perfectly” horizontally, starting
from an orthographic front view.
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Introduction to Visual Styles
A 3D model can be displayed in a variety of visual styles. A visual style controls the display
of edges and shading in a viewport. There are five basic visual styles—2D wireframe, 3D
wireframe, 3D hidden, conceptual, and realistic. A wireframe display shows all lines on the
object, including those representing back or internal features. A hidden display suppresses the
display of lines that would normally be hidden by surfaces in the foreground.
To change styles, you can use the drop-down list in the Visual Styles control panel in the
Dashboard. See Figure 7.
In the default 3D environment based on the
acad3D.dwt template, the default display mode,
or visual style, is Realistic. In this visual style, all
objects appear as solids and are displayed in
their assigned layer colors. Other display options
are available, but are not discussed in this class.
• 2D Wireframe This mode displays all
lines of the model using assigned
linetypes and lineweights. The 2D UCS
icon and 2D grid are displayed, if turned
on. If the HIDE command is used to

Figure 7. The Visual Styles from the Dashboard

display a hidden line view, use the
REGEN command to redisplay the wireframe view.
•

3D Wireframe Displays all lines of the model. The 3D grid and the 3D UCS icon are
displayed, if turned on.

•

3D Hidden Displays all visible lines of the model from the current viewpoint and hides
all lines not visible. Objects are not shaded or colored.

•

Conceptual The object is smoothed and shaded with transitional colors to help highlight
details.

•

Realistic Displays the shaded and smoothed model using assigned layer colors and
materials.
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Note
When the visual style is 2D Wireframe, you can quickly view the model with hidden lines
removed by selecting Hide from the View pull-down menu or typing HIDE. The HIDE command
can be used at any time to remove hidden lines from a wireframe display. If HIDE is used when
the current visual style is 3D Wireframe, Conceptual, or Realistic, the 3D Hidden visual style is
set current.

EXERCISE #6
1. It probably is open, but if not, open the DICE.dwg file
2. Try each of the various Visual Styles. Your results should look similar to the following
images in Figures 8 - 13.

Figure 8. 2D Wireframe

Figure 9. 3D Wireframe

Figure 11. Conceptual

Figure 12. Realistic
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Figure 10. 3D Hidden

Figure 13. Visual Style 1 (custom)
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Constructing Solid Primitives
As mentioned in the opening paragraph, a primitive is a basic building block. The eight
solid primitives in AutoCAD are a box, wedge, pyramid, cylinder, cone, sphere, torus, and
polysolid. These primitives can also be used as building blocks for complex solid models. This
section provides detailed information on drawing all of the solid primitives. All of the 3D
modeling primitive commands can be accessed using the 3D Make control panel in the
Dashboard, the Modeling toolbar, the Draw pull-down menu, or by typing the name of the 3D
modeling primitive. See Figure 14.
The information required to draw
a solid primitive depends on the type
of primitive being drawn. For example,
to draw a solid cylinder you must
provide a center point for the base, a
radius or diameter of the base, and

Figure 14. 3D Make Control Panel

the height of the cylinder. A variety of
command options are available when creating primitives, but each primitive is constructed using
just a few basic dimensions.
Certain familiar editing commands can be used on solid primitives. For example, you can
fillet or chamfer the edges of a solid primitive. In addition, there are other editing commands that
are specifically for use on solids. You can also perform Boolean operations on solids. These
operations allow you to add one solid to another, subtract one solid from another, or create a
new solid based on how two solids overlap.

Using Dynamic Input and Dynamic Feedback
Dynamic input enables you to construct models in a “heads up” fashion with minimal eye
movement around the screen. When a command is initiated, the command prompts are then
displayed in the dynamic input area, which is at the lower-right corner of the crosshairs. As the
pointer is moved, the dynamic input area follows it. The dynamic input area displays values of
the cursor location, dimensions, command prompts, and command options (in a drop-down list).
Coordinates and dimensions are displayed in boxes called input fields. When command options
are available, a drop-down list arrow appears. Press the down arrow key on the keyboard to
display the list. You can use your pointer to select the option, or press the down arrow key until
17
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a dot appears by the desired option, then press [Enter].
For example, after selecting a modeling command such as BOX, the first item that appears
in the dynamic input area is the prompt to specify the first corner and a display of the X and Y
coordinate values of the crosshairs. At this point you can use the pointer to specify the first
corner or type coordinate values. Type the X value and then a comma or the [Tab] key to move
to the Y value input box. This locks the typed value and any movement of the pointer will not
change it.
Caution
When using dynamic input to enter coordinate values from the keyboard, it is important that you
avoid pressing [Enter] until you have completed the coordinate entry. When you press [Enter],
all of the displayed coordinate values are accepted and the next command prompt appears.
In addition to entering coordinate values for sizes of solid primitives, you can provide direct
distance dimensions. For example, the second prompt of the BOX command is for the second
corner of the base. When you move the pointer, two dimensional input fields appear. Also,
notice that a preview of the base is shown in the drawing area. This is the dynamic feedback
that AutoCAD provides as you create a solid primitive. If you type a dimension at the keyboard
and press the [Tab] key, the value is the length of the side. Then, type a dimension for the width
of the base and press [enter], or press the left mouse button to set the base. But, if you enter a
value followed by a comma, the dynamic input area changes to display X and Y coordinate
boxes. In this case, the values entered are the X, Y, and Z coordinates of the opposite corner of
the box base.
After establishing the location and size of the box base, the next prompt asks you to specify
the height. Again, you can either enter a direct dimension value and press [Enter] or select the
height with the pointer. AutoCAD provides dynamic feedback on the height of the box as the
pointer is moved.
Professional Tip
When the BOX command prompts you to specify the other corner, and dynamic input is on, you
can provide the coordinates for the opposite corner of the box to see the shape and size of the
box before completing the command. To do this, type the X coordinate value and a comma.
This changes the dynamic input area from direct distance input to coordinate input. Next, type
the Y value and a comma, type the Z value, and press the [Tab] key. When all three values are
entered, the preview is displayed, but the command is not complete. Press the [Tab] key to
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cycle between the coordinate input boxes and type new values as needed. To complete the
command, press the [Enter] key.
Note
The techniques described above can be used with any form of dynamic input. The current input
field is always highlighted. You can always enter a value and use the [Tab] key to lock the input
and move to the next field.

Box
A box has six flat sides and forms
square corners. It can be constructed
starting from an initial corner or the
center. A cube can be constructed,
as well as a box with unequal sides.
When the command is initiated,

Figure 15. The BOX command on the 3D Make Control Panel

you are prompted to select the first
corner or enter the Center option. The first corner is one corner on the base of the box. The
center is the geometric center of the box, in each of the X, Y, and Z directions, not just the
center of the base (only the X and Y directions). If you select the Center option, you are next
prompted to select the center point.
After selecting the first corner or center, you are prompted to select the other corner or
enter the Cube or Length option. The “other” corner is the opposite corner of the box base if
you enter an XY coordinate, or the opposite corner of the box if you enter an XYZ coordinate. If
the Length option is entered, you are first prompted for the length of one side. If dynamic input
is on, you can also specify a rotation angle. After entering the length, you are prompted for the
width of the box base. If the Cube option is selected, the length value is applied to all sides of
the box.
Once the length and width of the base are established, you are prompted for the height,
unless the Cube option was selected. Either enter the height or select the 2point option. This
option allows you to pick two points on screen to set the height. The box is created.
Professional Tip
If dynamic UCS is on, you can select a surface that is not parallel to the current UCS on which
to locate the object. This feature is called a dynamic UCS and discussed in detail in Chapter 4.
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EXERCISE #7
1. Begin a new drawing based on the acad3D.dwt template.
2. Select the BOX command.
3. Pick a point for the first corner.
4. Use dynamic input to enter dimensional values for the length and width of the box.
5. Use dynamic input to enter a dimensional value for the height of the box.
6. Start the BOX command again, and pick the first corner. Enter an X coordinate value
and a comma.
7. Enter the Y and Z values without completing the command (do not hit [enter]). Use the
[tab] key toggle between and re-enter the XYZ values to change the shape and size of
the box. Complete the command.

Wedge
A wedge has five sides, four of
which are at right angles and the fifth
at an angle other than 90°. Once the
command is initiated, you are
prompted to select the first corner of
the base or to enter an option. By

Figure 16. The WEDGE command on the 3D Make Control Panel

default, a wedge is constructed by
picking diagonal corners of the base and setting a height. To pick the center point, enter the
Center option. The center point of a wedge is the middle of the angled surface. You must then
pick a point to set the width and length before entering a height. If dynamic input is on, you can
also set a rotation angle for the wedge.
After specifying the first corner or the center, you can enter the length, width, and height
instead of picking a second corner. When prompted for the second corner, enter the Length
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option and specify the length. You are then prompted for the width. After the width is entered,
you are prompted for the height.
To create a wedge with equal length, width, and height, enter the Cube option when
prompted for the second corner. Then, enter a length. The same value is automatically used for
the width and height. Polar tracking is a good feature to use with this option.

Pyramid
A pyramid has a base composed
of straight-line segments and edges
that converge at a single point. The
pyramid base can be composed of
three to 32 sides, much like a 2D
polygon. A pyramid may be drawn

Figure 17. The PYRAMID command on the 3D Make Control Panel

with a pointed apex or as a frustum
pyramid, which has a truncated, or flat, apex.
Once the command is initiated, you are prompted for the center of the base or to enter an
option. To set the number of sides on the base, enter the Sides option. Then, enter the number
of sides. You are returned to the first prompt.
The base of the pyramid can be drawn by either picking the center and the radius of a base
circle or by picking the endpoints of one side. The default method is to pick the center. Simply
specify the center and then set the radius. To pick the endpoints of one side, enter the Edge
option. Then, pick the first endpoint of one side followed by the second endpoint. If dynamic
input is on, you can also set a rotation angle for the pyramid.
If drawing the base from the center point, the polygon is circumscribed about the base circle
by default. To inscribe the polygon on the base circle, enter the Inscribed option before setting
the radius. To change back to a circumscribed polygon, enter the Circumscribed option before
setting the radius.
After locating and sizing the base, you are prompted for the height. To create a frustum
pyramid, enter the Top radius option. Then, set the radius of the top circle. The top will be
either inscribed or circumscribed based on the base circle. You are then returned to the height
prompt.
The height value can be set by entering a direct distance. You can also use the 2point
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option to set the height. With this option, pick two points on screen. The distance between the
two points is the height value. The Axis endpoint option can also be used to specify the center
of the top in the same manner as a cone or cylinder.

Cylinder
A cylinder has a circular or
elliptical base and edges that extend
perpendicular to the base. When the
command is initiated, you are
prompted for the center point of the
cylinder base or to enter an option.

Figure 18. The CYLINDER command on the 3D Make Control Panel

If you pick the center, you must
then set the radius of the base. To specify a diameter, enter the Diameter option after
specifying the center.
The 3P, 2P, and Ttr options are used to define a circular base using either three points on
the circle, two points on the circle, or two points of tangency on the circle and a radius. The
Elliptical option is used to create an elliptical base.
If the Elliptical option is entered, you are prompted to pick both endpoints of one axis and
then one endpoint of the other axis. If the Center option is entered, you are asked to select the
center of the ellipse and then pick an endpoint on each of the axes.
After the base is defined, you are asked to specify a height or to enter the 2point or Axis
endpoint option. The 2point option is used to set the height by picking two points on screen.
The distance between the points is the height. The Axis endpoint option allows you to orient
the cone at any angle, regardless of the current UCS, just as with a cone.
The Axis endpoint option is useful for placing a cylinder inside of another object to create a
hole. The cylinder can then be subtracted from the other object to create a hole. If the axis
endpoint does not have the same X and Y coordinates as the center of the base, the cylinder is
tilted from the XY plane.
If polar tracking is on when using the Axis endpoint option, you can rotate the cylinder axis
90

from the current UCS Z axis, and then turn the cylinder to any preset polar increment. If the

polar tracking vector is parallel to the Z axis of the current UCS, the tooltip displays a positive or
negative Z value.
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Cone
A cone has a circular or elliptical
base with edges that converge at a
single point. The cone may be
truncated so the top is flat and the
cone does not have an apex. When
the command is initiated, you are

Figure 19. The CONE command on the 3D Make Control Panel

prompted for the center point of the
cone base or to enter an option. If you pick the center, you must then set the radius of the base.
To specify a diameter, enter the Diameter option after specifying the center.
The 3P, 2P, and Ttr options are used to define a circular base using either three points on
the circle, two points on the circle, or two points of tangency on the circle and a radius. The
Elliptical option is used to create an elliptical base.
If the Elliptical option is entered, you are prompted to pick both endpoints of one axis and
then one endpoint of the other axis. If the Center option is entered after the Ellipse option, you
are asked to select the center of the ellipse and then pick an endpoint on each of the axes.
After the base is defined, you are asked to specify a height. You can enter a height or enter
the 2point, Axis endpoint, or Top radius option. The 2point option is used to set the height by
picking two points on screen. The distance between the points is the height.
The Axis endpoint option allows you to orient the cone at any angle, regardless of the
current UCS. For example, to place a tapered cutout in the end of a block, first create a
construction line. Then, locate the cone base and give a coordinate location of the apex, or axis
endpoint. You can then use editing commands to subtract the cone from the box to create the
tapered hole.
The Top radius option allows you to specify the radius of the top of the cone. If this option
is not used, the radius is zero, which creates a pointed cone. Setting the radius to a value other
than zero produces a frustum cone, or a cone where the top is truncated and does not come to
a point.

Sphere
A sphere is a round, smooth object like a baseball or globe. Once the command is initiated,
you are prompted for the center of the sphere or to enter an option. If you pick the center, you
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must then set the radius of the sphere. To specify a diameter, enter the Diameter option after
specifying the center. The 3P, 2P, and Ttr options are used to define the sphere using either three
points on the surface of the sphere,
two points on the surface of the
sphere, or two points of tangency on
the surface of the sphere and a radius.
Spheres and other curved
objects can be displayed in a
number of different ways. The

Figure 20. The SPHERE command on the 3D Make Control Panel

manner in which you choose to
display these objects should be governed by the display requirements of your work. Notice the
lines that define the shape of the spheres in a wireframe display. These lines are called contour
lines, also known as tessellation lines. The Visual Styles Manager can be used to set the
display of contour lines and silhouettes on spheres and other curved 3D surfaces for a given
visual style.
With the Visual Styles Manager displayed, select the 2D Wireframe image tile. The
Contour lines setting in the 2D Wireframe options area establishes the number of lines used
to show the shape of curved objects. A similar setting appears in the 3D Wireframe, 3D Hidden,
Conceptual, and Realistic visual styles if their Edge mode option is set to Isolines. The default
value is four, but can be set to a value from zero to 2047. It is best to use a lower number during
construction and preliminary displays of the model and, if needed, higher settings for more
realistic visualization. The contour lines setting is also available in the Display tab of the
Options dialog box or by typing ISOLINES.
The Draw true silhouettes setting in the 2D Wireframe options area controls the display
of silhouettes on 3D solid curved surfaces. The setting is either Yes or No. The Draw true
silhouettes setting is stored in the DISPSILH system variable.
Professional Tip
The Visual Style control panel in the Dashboard can also be used to change the contour lines
and silhouettes without changing the visual style definition. This is discussed in Chapter 3.

Torus
A basic torus is cylinder bent into a circle, similar to a doughnut or inner tube. There are
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three types of tori. A torus with a tube diameter that touches itself has no center hole. This is
the second type of torus and is called self intersecting. To create a self-intersecting torus, the
tube radius must be greater than the
torus radius. The third type of torus
looks like a football. It is drawn by
entering a negative torus radius and
a positive tube diameter of greater
value, i.e. –1 and 1.1.
Once the command is initiated,

Figure 21. The TORUS command on the 3D Make Control Panel

you are prompted for the center of
the torus or to enter an option. If you pick the center, you must then set the radius of the torus.
To specify a diameter, enter the Diameter option after specifying the center. This defines a
base circle that is the centerline of the tube. The 3P, 2P, and Ttr options are used to define the
base circle of the torus using either three points, two points, or two points of tangency and a
radius.
Once the base circle of the torus is defined, you are prompted for the tube radius or to enter
an option. The tube radius defines the cross-sectional circle of the tube. To specify a diameter
of the cross sectional circle, enter the Diameter option. You can also use the 2point option to
pick two points on screen that define the diameter of the cross-sectional circle.

Polysolid
The polysolid primitive is simply
a polyline that is constructed as a
solid object by applying a width and
height to the polyline. Many of the
options used to create polylines are
used with the POLYSOLID command. Figure 22. The POLYSOLID command on the 3D Make Control
Panel
The principal difference is that a solid
object is constructed using POLYSOLID.
When the command is initiated, you are prompted to select the first point or enter an option.
By default, the width of the polysolid is equally applied to each side of the line you draw. This is
center justification. Using the Justify option, you can set the justification to center, left, or right.
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The justification applies to all segments created in this command session. If you select the
wrong justification option, you must exit the command and begin again.
The default width is .25 units and height is four units. These values can be changed using
the Height and Width options of the command. The height value is saved in the PSOLHEIGHT
system variable. The width value is saved in the PSOLWIDTH system variable. Using these
system variables, the default width and height can be set outside of the command.
The Object option allows you to convert an existing 2D object into a polysolid. AutoCAD
entities such as lines, circles, arcs, polylines, polygons, and rectangles can be converted. The
2D object cannot be self intersecting. Some objects, such as 3D polylines and revision clouds,
cannot be converted.
Once you have set the first point on the polysolid, pick the endpoint of the first segment.
Continue adding segments as needed and press [Enter] to complete the command. After the
first point is set, you can enter the Arc option. The current segment will then be created as an
arc instead of a straight line. Arc segments will be created until you enter the Line option. The
suboptions for the Arc option are:
•

Close. If there are two or more segments, this option creates an arc segment between
the active point and the first point of the polysolid.

•

Direction. Specifies the tangent direction for the start of the arc.

•

Line. Returns the command to creating straight line segments.

•

Second point. Locates the second point of a two-point arc. This is not the endpoint of
the segment.

Constructing a Planar Surface
A planar surface primitive is an
object consisting of a single plane,
and is created parallel to the current
XY plane. The surface that is created
has zero thickness and is composed
of a mesh of lines. It is created with
the PLANESURF command. The

Figure 23. The PLANESURF command on the 3D Make Control
Panel

command prompts you to specify the first corner and then the second corner of a rectangle.
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Once drawn, the surface is displayed as a mesh with lines in the X and Y directions. These lines
are called isolines and do not include the object’s boundary. The SURFU (Y axis) and SURFV
(X axis) system variables determine how many isolines are created when the planar surface is
drawn. The isoline values can be changed later using the Properties window. The maximum
number of isolines in either direction is 200.
The Object option of the PLANESURF command allows you to convert a 2D object into a
planar surface. Any existing object or objects lying in a single plane and forming a closed area
can be converted to a planar surface.
Although a planar surface is not a solid, it can be converted into a solid in a single step
using the THICKEN command. The object that started as two arcs and two lines is now a solid
model and can be manipulated and edited like any other solid. This capability enables you to
create intricate planar shapes and quickly convert them to a solid for use in advanced modeling
applications.

EXERCISE #8
1. Begin a new drawing based on the acad3D.dwt template.
2. Use the current 3D viewpoint, or choose one using the 3DORBIT command.
3. Construct the following solid primitives.
• A sphere 1.5 in diameter.
• A cone 2.5 high with a base diameter of 1.5.
• A box that is 3 × 2 × 1.
• A wedge 4 long, 3 wide, and 2 high.
• A cylinder 1.5 in diameter and 2.5 high.
• A basic torus with a radius of 2 and a tube diameter of .75.
• A pyramid with a base diameter of 2 and a height of 3.
• A frustum pyramid with a base diameter of 2, an apex (Top) diameter of .5., and height
of 2.5.
• A polysolid 2 thick and 6 high using a variety of straight lines and curves.
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Grip Editing Solid Primitives
There are three basic types of 3D solids in AutoCAD. The commands BOX, WEDGE,
CYLINDER, SPHERE, etc., create 3D solid primitives. Sweeps are 2D profiles given thickness
by the EXTRUDE, REVOLVE, SWEEP, and LOFT commands to create a 3D solid. Finally, 3D
solid composites are created by a Boolean operation or by using the SOLIDEDIT command.
There are two types of grips—base and parameter—that may be associated with a solid object.
These grips provide an intuitive means of modifying solids. Base grips are square and
parameter grips are typically arrows. The editing that can be performed with these grips are
discussed in the next sections. The 3D solid primitives (box, wedge, pyramid, cylinder, cone,
sphere, and torus) all have basically the same grips. However, not all grips are available on all
primitives. All primitives have a base grip at the centroid of the base. This grip functions like a
standard grip in 2D work. It can be used to stretch, move, rotate, scale, or mirror the
solid.Boxes, wedges, and pyramids have square base grips at the corners that allow the size of
the base to be changed. See Figure 24. Select one of these grips, move the cursor, and select

Figure 24. Grips as shown on a Box, Wedge, and Pyramid

a new point. The object dynamically changes in the viewport as you move the grip. You can also
type the new coordinate location for the grip and press [Enter]. If ortho is off, the length and
width can be changed at the same time by dragging the grip, except in the case of a pyramid.
The parameter grips on the base allow the length or width to be changed. Additionally, the
height of these objects can be changed using parameter grips. Each object has one parameter
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grip for changing the height of the apex and one for changing the height of the plane on which
the base sits. A pyramid also has a parameter grip at the apex for changing the radius of the
top.
Cylinders, cones, and spheres have four parameter grips for changing the radius of the
base, or the cross section in the case of a sphere. See Figure 25.

Figure 25. Grips as shown on a Cylinder, Cone, and Sphere

Cylinders and cones also have parameter grips for changing the height of the apex and the
height of the plane on which the base sits. Additionally, a cone has a parameter grip at the apex
for changing the radius of the top.
A torus has a parameter grip located at the center of the tube. See Figure 26. This grip is
used to change the radius of the torus. There is also a
parameter grip at each quadrant of the tube. These are used
to change the radius of the tube.
A polysolid does not have parameter grips. Instead, a
base grip appears at
Figure 26. Grips as shown on a Torus

each corner of the
starting face of the

solid. See Figure 27. Use these grips to change the cross
sectional shape of the polysolid. The corners do not need
to remain square. Base grips also appear at the endpoint
of each segment centerline. Use these to change the
location of each segment’s endpoints.

Figure 27. Grips as shown on a Polysolid

29

3D Visualization and Solid Primitive Conceptual Modeling in AutoCAD®

EXERCISE #9
1. Well, I am sure you are doing it already, but go ahead and use the grips and start
modifying your solids primitives from the previous exercise.

Overview of Subobject Editing
AutoCAD solid primitives, such as cylinders, wedges, and boxes, are composed of three
types of subobjects: faces, edges, and vertices. In addition, the objects that are used with
Boolean commands to create a composite solid are considered subobjects, if the history is
recorded. The primitive subobjects can be edited. Once selected, the primitive subobjects can
even be deleted from the composite solid.
Subobjects can be easily edited using grips, which provide an intuitive and flexible method
of solid model design. For example, suppose you need to rotate a face subobject in the current
XY plane. You can select the subobject, pick its base grip, and then cycle through the editing
functions to ROTATE. You can also use the ROTATE command on the selected subobject.

Selecting Subobjects
To select a subobject, press the [Ctrl] key and pick the subobject. You can select multiple
subobjects and subobjects on multiple objects. To select a subobject that is hidden in the
current view, first display the model as a wireframe. After creating a selection set, select a grip
and edit the subobject as needed. Multiple objects can be selected in this manner. To deselect
objects, press the [Shift]+[Ctrl] key combination and pick the objects to be removed from the
selection set.
If objects or subobjects are overlapping, press the [Ctrl] key and the spacebar to turn on
cycling and pick the subobject. Then, release the spacebar, continue holding the [Ctrl] key, and
pick until the subobject you need is highlighted. Press [Enter] or the spacebar to select the
highlighted subobject.
The [Ctrl] key method can be used to select subobjects for use with editing commands such
as MOVE, COPY, ROTATE, SCALE, ARRAY, and ERASE. Some commands, like ARRAY,
STRETCH, and MIRROR, are applied to the entire solid. Other operations may not be applied at
all, depending on which type of subobject is selected. You can also use the Properties window
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to change the color of edge and face subobjects or the material assigned to a face. The color of
a subobject primitive can also be changed, but not the color of its subobjects.

Presspull
The PRESSPULL command
allows any closed boundary to be
extruded. The boundary can be a flat
surface, a closed polyline, a circle, or
a region. The extrusion is always
applied perpendicular to the plane of
the boundary, but can be in the

Figure 28. The PRESSPULL command on the 3D Make Control
Panel

positive or negative direction. When
applied to the face of a solid, it is very similar to the Extrude Face option of the SOLIDEDIT
command, though dynamic feedback is provided for the extrusion with PRESSPULL.
Once the command is initiated, you are prompted to pick inside of the bounded areas to
extrude. Move the pointer inside of a boundary and pick. Then, drag the boundary to a new
location and pick or, if dynamic input is on, enter the distance to extrude the face.
Note
The entire boundary must be visible on the screen, or the loop will not be found.

Shell
A shell is a solid that has been
“hollowed out.” The Shell option of
the SOLIDEDIT command creates a
shell of the selected object using a

Figure 29. The SHELL button on the Solid Editing toolbar

specified offset distance, or thickness.
To create a shell of a solid body, select the button shown in Figure 29 from the Solid Editing
toolbar. You are prompted to select the solid. Only one solid can be selected.
After selecting the solid, you have the opportunity to remove faces. If you do not remove
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any faces, the new solid object will appear identical to the old solid object when shaded or
rendered. The thickness of the shell will not be visible. If you wish to create a hollow object with
an opening, select the face to be removed (the opening).
After selecting the object and specifying any faces to be removed, you are prompted to
enter the shell offset distance. This is the thickness of the shell. A positive shell offset distance
creates a shell on the inside of the solid body. A negative shell offset distance creates a shell on
the outside of the solid body. If you shell a solid that contains internal features, such as holes,
grooves, and slots, a shell of the specified thickness is placed around those features.

Caution
Using the SOLIDEDIT command removes the history from a composite solid. Therefore, the
original objects—the subobjects—are no longer available for subobject editing. However, you
may still be able to perform some subobject edits, such as moving the original objects.

Creating Composite Solids
A composite solid is a solid model constructed of two or more solids, often primitives.
Solids can be subtracted from each other, joined to form a new solid, or overlapped to create an
intersection or interference. The commands used to create composite solids are found in the 3D
Make control panel in the Dashboard, in the Solid Editing cascading menu in the Modify pulldown menu, and on the Solid Editing toolbar.

Introduction to Booleans
There are three operations that form the basis of constructing many complex solid models.
Joining two or more solids is called a union operation. Subtracting one solid from another is
called a subtraction operation. Forming a solid based on the volume of overlapping solids is
called an intersection operation. Unions, subtractions, and intersections as a group are called
Boolean operations. George Boole (1815–1864) was an English mathematician who
developed a system of mathematical logic where all variables have the value of either one or
zero. Boole’s two-value logic, or binary algebra, is the basis for the mathematical calculations
used by computers, and specifically for those required in the construction of composite solids.
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Joining Two or More Solid Objects
The UNION command is used to
combine solid objects, Figure 30. The
solids do not need to touch or
intersect to form a union. Therefore,
accurately locate the primitives when
drawing them. After selecting the
objects to join, just press [Enter] and
the action is completed.

Figure 30. The UNION command on the 3D Make Control Panel

Subtracting Solids
The SUBTRACT command allows you to remove the volume of one or more solids from
another solid. See Figure 31. The first
object selected in the subtraction
operation is the object from which
volume is to be subtracted. The next
object is the object to be subtracted
from the first. The completed object
will be a new solid. If the result is the
opposite of what you intended, you
may have selected the objects in the

Figure 31. The SUBTRACT command on the 3D Make Control
Panel

wrong order. Just undo the operation and try again.

Creating New Solids from the Intersection of Solids
When solid objects intersect, the
overlap forms a common volume, a
space that both objects share. This
shared space is called an
intersection. An intersection can be
made into a composite solid using the
INTERSECT command. See Figure 32.

Figure 32. The INTERSECT command on the 3D Make Control
Panel

A solid is formed from the common
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volume. The original objects are removed.

Grip Editing Composite Solids
The Boolean commands (UNION, SUBTRACT, and INTERSECT) create composite solids.
Solids that have been modified using any of the options of the SOLIDEDIT command also
become composite solids. The solid may still look like a primitive, sweep, loft, etc., but it is a
composite. The grips available with the previous objects are no longer available, unless
performing subobject editing on a composite created with a Boolean command (discussed later
in this chapter). Composite solids have a base grip located at the centroid of the base surface.
This grip can be used to stretch, move, rotate, scale, or mirror the solid.
Note
When performing grip editing on a solid, AutoCAD must be able to “solve” the end result. If it
cannot, the edit is not applied.
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EXERCISE #9
1. Well, let’s put these last few things together – and even do something we haven’t quite
covered yet.
2. Draw a BOX with dimensions of 6L x 3W x 2H
3. To the right of the BOX, draw a WEDGE with dimensions of 3L x 2W x 1H
4. Use grips on the WEDGE to “mate” the vertical face of the WEDGE with the end of the
BOX. Do not worry about the length of the WEDGE changing while doing the grip edits.
5. We are now going to draw a cylinder on the inclined surface. This is the automatic part!
Be sure the DUCS button is pushed in on the status bar. After initiating the CYLINDER
command, hover the crosshairs over the inclined surface, while being prompted to select
the center point. Notice the crosshairs change orientation to align with the surface. Use
the “Midpoint between 2 Points” option from the object snap menu, to center the cylinder
between the opposite midpoints or endpoints. Enter 1 for the radius, and “pull” the
height of the cylinder to a point below the wedge.
6. We can now subtract the cylinder from the wedge and the box, forming a hole – and
turning the result into one composite solid. Select the SUBTRACT command. When
prompted to select objects to subtract from, select the box and the wedge, and hit [enter].
When prompted to select objects to subtract, select the cylinder, and hit [enter]. Notice that
the solids are now one object, a composite solid.
7. Finally, we will hollow out our new solid from the bottom, with .15 thick “walls”. Use your
viewing tools to create a view allowing you to see the bottom of the solid; we will need to
select it soon. Select the SHELL command from the Solid Editing toolbar. Select the solid
when prompted to do so. Select the bottom face when prompted to select faces to be
removed, and hit [enter]. Enter .15 when prompted for the shell offset distance. Since
“Shell” is actually a nested option to the “Body” option of the SOLIDEDIT command, you will
need to hit [enter] to exit the “Body” option, then hit [enter] again to exit the SOLIDEDIT
command.
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8. Experiment with the various Visual Styles to view your new solid. Be sure to try the
“Conceptual” style with the X-ray mode turned on – that is one of my favorite settings for
working in a solid modeling environment.

Introduction to Working with User Coordinate Systems
All points in a drawing or on an object are defined with XYZ coordinate values (rectangular
coordinates) measured from the 0,0,0 origin. Since this system of coordinates is fixed and
universal, AutoCAD refers to it as the world coordinate system (WCS). A user coordinate
system (UCS), on the other hand, can be defined with its origin at any location and with its
three axes in any orientation desired, while remaining at 90° to each other. The UCS command
is used to change the origin, position, and rotation of the coordinate system to match the
surfaces and features of an object under construction. When set up to do so, the UCS icon
reflects the changes in the orientation of the UCS and placement of the origin.
The available options for creating and managing a UCS are found in the Tools pull-down
menu and related cascading menu, on the UCS and UCS II toolbars, or by typing the UCS
command.

Displaying the UCS Icon
Before getting started with the various UCS command options it is best to become familiar
with the symbol that identifies the orientation of the coordinate system called the UCS icon.
When AutoCAD is first launched based on the acad3D.dwt template, the UCS icon is located at
the WCS origin in the middle of viewport. The display of this symbol is controlled by the
UCSICON command. If your drawing does not require viewports and altered coordinate
systems, you may want to turn the icon off using the OFF option of the command. The icon
disappears until you turn it on again using the ON option of the command. You can also turn the
icon on or off and set the icon to display at the origin using the options in the Settings tab of the
UCS dialog box. This dialog box is displayed by picking the Named UCS… button on the UCS II
toolbar, selecting Tools>Named UCS…, or typing the UCSMAN command.
Professional Tip
It is recommended that you have the UCS icon turned on at all times when working in 3D
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drawings. It provides a quick indication of the current UCS.

Changing the Coordinate System
To construct a three-dimensional object, you must draw shapes at many different angles.
Different working planes are needed to draw features on angled surfaces. To construct these
features, you must very often manipulate the UCS to match any surface on an object. The
following options to the UCS command are some of the more common ways of manipulating the
UCS.

Selecting Three Points to Create a New UCS
The 3 Point option of the UCS command can be used to change the UCS to any flat
surface. This option requires that you first locate a new origin, then a point on the positive X
axis, and finally a point on the XY plane that has a positive Y value. Use object snaps to select
points that are not on the current XY plane. After you pick the third point, the point on the XY
plane, the UCS icon changes its orientation to align with the angled surface of the base.
Professional Tip
When typing the UCS command, enter 3 at the Specify origin of UCS or
[Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis] <World>: prompt. Notice that the option
is not listed in the prompt.

Naming and Saving a UCS
Once you have created a new UCS that may be used again, it is best to save it for future
use. For example, you have created a UCS that you used to draw the wireframe of one side of
the object. You can save this UCS using the Save option of the UCS command or the UCS
dialog box.
If using the dialog box, right-click on the entry Unnamed and pick Rename in the shortcut
menu. You can also pick once or double-click on the highlighted name. Then, type the new
name in place of Unnamed and press [Enter]. A name can have up to 255 characters. Numbers,
letters, spaces, dollar signs ($), hyphens (–), and underscores (_) are valid. Use this method to
save a new UCS or to rename an existing one. Now, the coordinate system is saved and can be
easily recalled for future use.
Professional Tip
Most drawings can be created by rotating the UCS as needed without saving it. If the drawing is
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complex with several planes, each containing a large amount of detail, you may wish to save a
UCS for each detailed face. Then, restore the proper UCS as needed. For example, when
working with architectural drawings, you may wish to establish a different UCS for each floor
plan and elevation view, and for roofs and walls that require detail work.

Setting the UCS to an Existing Object
The Object option of the UCS command can be used to define a new UCS on an object.
However, there are some objects on which this option cannot be used: 3D polylines, 3D
meshes, and xlines. There are also certain rules that control the orientation of the UCS. For
example, if you select a circle, the center point becomes the origin of the new UCS. The pick
point on the circle determines the direction of the X axis. The Y axis is relative to X, and the
UCS Z axis is the same as the Z axis of the selected object.

Setting the UCS to the Face of a 3D Solid
The Face option of the UCS command allows you to orient the UCS to any face on a 3D
solid object. Select the command and then pick a face on the solid. After you have selected a
face on a 3D solid, you have the options of moving the UCS to the adjacent face or flipping the
UCS 180° on the X, Y, or both axes. Use the Next, Xflip, or Yflip options to move or rotate the
UCS as needed. Once you achieve the UCS orientation you want, press [Enter] to accept. Be
aware there are many different UCS orientations that can be selected for a single face.

Dynamic UCS
A powerful tool for 3D modeling is the dynamic UCS function. A dynamic UCS is a UCS
temporarily located on any existing face of a 3D model. The function is activated by picking the
DUCS button in the status bar, pressing the [Ctrl]+[D] key combination, or setting the
UCSDETECT system variable to 1. When the pointer is moved over a model surface, the XY
plane of the UCS is aligned with that surface. This is especially useful when adding primitives or
shapes to model surfaces. In addition, dynamic UCSs are useful when inserting blocks and
xrefs, locating text, editing 3D geometry, editing with grips, and area calculations.
An example of using dynamic UCS is to draw a cylinder on the angled face of an object, say
a wedge. First, select the CYLINDER command. Make sure the dynamic UCS function is on.
Then, move the pointer over one of the surfaces of the object. Notice that the 3D crosshairs
change when they are moved over a new surface. The red (X) and green (Y) crosshairs are flat
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on the face. For ease of visualizing the 3D crosshairs as they are moved across different
surfaces, right-click on the DUCS button in the status bar and select Display crosshair labels
to turn on the XYZ labels on the crosshairs.
As you move the pointer over the object faces, note that hidden faces are not highlighted,
therefore you cannot work on those faces. If you wish to work on a hidden face you must first
change the viewpoint to make that face visible.
The CYLINDER command is currently prompting to select a center point of the base. If you
pick a point, this sets the center of the cylinder base and temporarily relocates the UCS so its
XY plane lies on the selected face. Once the point is selected and the dynamic UCS created,
the UCS icon moves to the temporary UCS. When the command is ended, the UCS and UCS
icon revert to their previous locations. To locate a cylinder in the center of the angled face, use
the following procedure.
1. At the “specify center point of base” prompt, [Shift] + right-click in the drawing area and
pick Mid Between 2 Points from the object snap shortcut menu.
2. Use the Endpoint snap to pick two opposite corners of the angled face. You can also
use the Midpoint snap and pick the midpoint of the two sides or top and bottom edges.
The UCS is temporarily moved to the angled face at the pick point.
3. Specify the diameter for the base.
4. Specify the height for the cylinder.
5. The cylinder is located properly on the angled face and the UCS automatically returns
to the previous location.
When setting a dynamic UCS, experiment with the behavior of the crosshairs as they are
moved over different surfaces. The orientation of the crosshairs is related to the edge of the
face that they are moved over. Can you determine the pattern by which the crosshairs are
turned? The X axis of the crosshairs is always aligned with the edge that is crossed.
Professional Tip
If you want to temporarily turn off the dynamic UCS function while working in a command, press
and hold the [Shift]+[Z] key combination while moving the pointer over a face. As soon as you
release the key, dynamic UCS function is reinstated.

Preset UCS Orientations
AutoCAD has six preset orthographic UCSs that match the six standard orthographic views.
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These orientations can be selected in the drop-down list that appears on the UCS II toolbar, in
the Tools pull-down menu, or in the Orthographic UCSs tab of the UCS dialog box.
The Relative to: drop-down list at the bottom of the Orthographic UCSs tab of the UCS
dialog box specifies whether the orthographic UCS is relative to a named UCS or absolute to
the WCS. For example, suppose you have a saved UCS named Front Corner that is rotated 30°
about the Y axis of the WCS. If you set the top UCS current relative to the WCS, the new UCS
is perpendicular to the WCS. However, if the top UCS is set current relative to the named UCS
Front Corner, the new UCS is also rotated from the WCS.
Professional Tip
Changing the Relative to: setting affects all preset UCSs and all preset viewpoints! Therefore,
leave this set to World unless absolutely necessary to change it.

UCS Settings and Variables
As discussed in the previous section, the UCSFOLLOW system variable allows you to
change how an object is displayed in relation to the UCS. There are also system variables that
display a variety of information about the current UCS. These variables include:
•

UCSAXISANG. (Stored value) The default rotation angle for the X, Y, or Z option of the
UCS command.

•

UCSDETECT. (On or off) Turns the dynamic UCS function on and off. The DUCS button
on the status bar controls this variable, as does the [Ctrl]+[D] key combination.

•

UCSORTHO. (On or off) If set to 1 (on), the related orthographic UCS setting is
automatically restored when an orthographic view is restored. If turned off, the current
UCS is retained when an orthographic view is restored.

•

UCSNAME. (Read only) Displays the name of the current UCS.

•

UCSORG. (Read only) Displays the XYZ origin value of the current UCS.

•

UCSVIEW. (On or off) If this variable is set to 1 (on), the current UCS is saved with the
view when a view is saved. Otherwise, the UCS is not saved with the view.

•

UCSXDIR. (Read only) Displays the XYZ value of the X axis direction of the current
UCS.

•

UCSYDIR. (Read only) Displays the XYZ value of the Y axis direction of the current
UCS.

UCS options and variables can also be managed in the Settings tab of the UCS dialog box.
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The settings in this tab are:
•

Save UCS with viewport. If checked, the current UCS settings are saved with the
viewport and the UCSVP system variable is set to 1. This variable can be set for each
viewport in the drawing. Viewports in which this setting is turned off, or unchecked, will
always display the UCS settings of the current active viewport.

•

Update view to Plan when UCS is changed. This setting controls the UCSFOLLOW

variable. When checked, the variable is set to 1. When unchecked, the variable is set to 0.
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